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[bookmark: _Toc220570384]Terms
	Term
	Definition

	Alphanumerical information
	Structured Information expressed using characters, digits and symbols or tokens. May be attached or linked to geometry. Further described in ISO 7817-1:2024.

	Appointed party
	A provider of information for the project, including services and typically has a lead party such as an architect or managing contractor.

	Asset Information Model (AIM)
	Information model relating to the operational stage. As per AS ISO 19650.

	Asset Information Requirements (AIR)
	Information requirements in relation to the operation of the asset. As per AS ISO 19650.

	BIM Execution Plan (BEP)
	A detailed plan, created from the Queensland Health BEP template, that documents the use of Building Information Modelling (BIM) on a project. It outlines who is responsible for what in the BIM process, when in the process they are responsible for it, and how they will execute Queensland Health requirements as specified in the Project Information Requirements (PIR) and Capital Infrastructure Requirements (CIR).

	BEP template
	The standard Queensland Health BEP template is to be used by delivery teams. Refers to Design BEP (DBEP) and Construction BEP (CBEP).

	Building Information Modelling (BIM)
	The use of a shared digital representation of a built asset to facilitate design, construction and operation processes to form a reliable basis for decisions.

	Building Information Models (BIM/s)
	Means all models that any contributing party (or its sub-contractors) is required to produce and deliver in accordance with the BEP, PIR and CIR.

	BIM manager
	A delivery team provides resources to manage the BIM and asset information creation processes on the project.

	Capital works
	The planning, design, construction and delivery of new assets or significant upgrades to existing infrastructure, typically funded through a capital investment program. In the context of Queensland Health, capital works include healthcare facilities and associated infrastructure delivered to meet service needs.

	Common Data Environment
	Cloud-based collaboration software to host design files, with an integration into BIM authoring software and other software.

	Delivery team
	A collection of appointed parties contributing to the capital works project, the composition of which may change according to the project requirements and schedule, but typically comprises design consultants, contractors and sub-contractors, as per AS ISO 19650. For the purposes of this document, the delivery team excludes Queensland Health and its internal project managers as its representatives.

	Exchange Information Requirements (EIR)
	Queensland Health requirements to enable the exchange of information from the Project Information Model (PIM) to the AIM. In this instance, the EIR is combined with the PIR to reduce the number of documents to be reviewed by the delivery team.

	Federated model
	An assembly of discipline/trade BIM/s combined for uses such as coordination, collaboration, and exchange with the appointing party.

	Geometrical information
	Structured Information, such as geometry-based Computer Aided Design (CAD) or BIM models. Further described in ISO 7817-1:2024.

	Key decision
	A business decision that Queensland Health values, which can be made using information created by the delivery team.

	Level of Development (LOD)
	The degree to which the element’s geometry and attached information have been progressed, and the degree to which delivery team members may rely on the information when using the model. Queensland Health doesn’t specify the LOD requirements per stage; however, if the delivery team wishes to use an LOD framework, the 2024 LOD specification published by the United States of America (USA) BIMForum shall be used as a guiding reference.

	Level of information
	The specific data associated with the individual objects within the BIM.

	Level of information need
	The Level of information need provides methods for describing information to be exchanged according to the EIR and namely the PIR, as per AS ISO 7817.1:2024.

	Laser scanning
	The process of capturing digital information about the shape of an object with equipment that uses a laser to measure the distance between itself and the object, resulting in a point cloud.

	Massing model
	An early volumetric model useful for understanding bulk and scale, areas of floor plates and departmental layouts and adjacencies.

	Model Content Plan (MCP)
	A Quantity Surveyor (QS) developed document that defines the modelling requirements (units of measure, codification) for the delivery team to enable the QS to perform cost estimating from BIM.

	Model element
	An individual component within a BIM (e.g. wall, floor, nurse call device, room, diffuser, column, etc.).

	Model element author
	A person responsible for creating an element (object) in the BIM environment.

	openBIM
	A universal approach to the collaborative design, realisation and operation of buildings based on open standards and workflows.

	Photogrammetry
	The process of extracting 3D information from photos or video to convert into digital models or point clouds.

	Project brief
	Queensland Health requirements for a specific project.

	Project Information Model (PIM)
	The information model relating to the delivery stage. The PIM consists of documentation, alphanumerical information and geometrical information of the project, typically using BIM, CAD and Geographic Information System (GIS). As per AS ISO 19650.

	Project Information Requirements (PIR)
	Queensland Health information requirements and exchange processes to enable the creation and management of the PIM to support the ongoing AIM (this document).

	Project manager
	A Queensland Health assigned resource to ensure the delivery team complies with the PIR and BEP, enabling the creation of the PIM and AIM. The project manager's responsibility is to manage the scope, time, cost, quality, resources, communications, and risk aspects of the project.

	Space planning platform
	Queensland Health use dRofus as their space planning tool, integrated with BIM. dRofus is used with a Health Infrastructure Queensland template for clinical planning, Furniture, Fixtures and Equipment (FF+E) management, and asset data consolidation and quality control, amongst other functions.




[bookmark: _Toc214446520]

[bookmark: _Toc220570385]Acronyms
	Abbreviated terms
	Definition

	3D
	Three-dimensional digital model

	AusHFG
	Australasian Health Facility Guidelines

	AIM
	Asset Information Model

	AIR
	Asset Information Requirements

	BIM
	Building Information Modelling

	BIM/s
	Building Information Models

	BEP
	BIM Execution Plan (refers to DBEP and CBEP)

	CAD
	Computer Aided Design/Drafting

	CBEP
	Construction BIM Execution Plan

	CDE
	Common Data Environment

	CIR
	Capital Infrastructure Requirements

	CMMS
	Computer Maintenance Management System

	DBEP
	Design BIM Execution Plan

	dMP
	dRofus Management Plan

	FF+E
	Furniture, Fixtures and Equipment

	HHS
	Hospital and Health Service

	HIQ
	Health Infrastructure Queensland 

	IFC
	Industry Foundation Classes 

	LOD
	Level of Development

	MCP
	Model Content Plan

	PIM
	Project Information Model

	PIR
	Project Information Requirements

	RDS
	Room Data Sheets

	SiD
	Safety in Design

	SoA
	Schedule of Accommodation




[bookmark: _Toc220570386]1 Purpose of this document
Using the Queensland Health Project Information Requirements (PIR), this Construction Building Information Modelling (BIM) Execution Plan (CBEP) template is to be populated in Microsoft Word by the tendering delivery team for the named project.
Track changes must be used to highlight any changes between the original document and all subsequent revisions. Once agreed by the delivery team and Queensland Health, accept changes and record a summary in the version history table on page 3.
The CBEP outlines the contractor’s proposed approach to using the design BIM/s and nominates the information management practices for construction and handover. Before the start of construction, the CBEP shall be reviewed, revised and agreed with Queensland Health project management, confirming the approach for construction.
The design BIM/s, if available, shall be used by the contractor to inform the tender price and shall be developed throughout construction, in alignment with the PIR, to ultimately produce as-built BIM/s containing asset data for the project that will be handed over to the Hospital and Health Service (HHS).
The delivery team is to use any of the following information sources to assist in the creation of this document, please reach out to the HIQ project director if you haven’t received those documents:
· Queensland Health Capital Infrastructure Requirements (CIR).
· Queensland Health PIR for BIM.
· Design BIM Execution Plan (DBEP) for the project.
· Design BIM/s, drawings, reports and schedules.
· Queensland Health asset equipment lists.
· Queensland Health BIM data uploader template.
· Queensland Health dRofus management plan.
· Any existing conditions HHS BIM/s.
· Existing 2D drawings, reports and schedules.
· Survey information, including laser scans.
· HHS information requirements (e.g. naming, coding, classifications).
· Functional design brief and any space planning information.
· AusHFG codes and guidelines.









The CBEP must be developed taking into consideration the Queensland Health PIR, CIR and current revision of the DBEP. The CBEP will be used as part of the assessment criteria for determining a preferred delivery team for construction stages.
The CBEP and federated model will be used by the HHS as the reference for how the as-built BIM was created.
[bookmark: _Toc220570387]1.1 Document structure
[bookmark: _Hlk13142000]The document is divided into commercial, managerial and technical sections in alignment with ISO 19650. The managerial section is further split into the logical project delivery stages. In this way, appointed parties can work through the project delivery stages, understanding the specific BIM requirements for each discipline/trade for the given stage. 
This document articulates how information shall be structured, managed and delivered by the delivery team contracted by Queensland Health, in alignment with the PIR. 
As changes during project delivery are inevitable, such as new delivery team members joining the project, the BEP shall be revised by the BIM manager when any new appointed party joins the project and/or before each new project stage commences.
	Instructional text (hidden blue text) for the lead appointed party
Instructional text is provided to assist the lead appointed party’s BIM manager in developing this document using Microsoft Word. If you do not see any blue text below, then enable visibility in:
File > Options > Display > check Hidden Text (blue text should be visible below).
Note: Hidden text should be turned off prior to publishing the document, and placeholder text [in square brackets] must be deleted.
DELETE THIS INSTRUCTIONAL NOTE BEFORE FINALISING THIS CBEP.



DOCUMENT USE—Instructional text is shown in this way. 

PIR section reference
DO NOT DELETE instructional text as it contains the section references to the Project Information Requirements (PIR) which will aid you in completing this document. Hide instructional text prior to issue to Queensland Health. To hide it, go to File > Options > Display > Hidden Text and uncheck the box. The final BEP may be issued to the wider delivery team as a PDF.

[bookmark: _Hlk107308397]Text in [square brackets]
All text in [square brackets] should be replaced with the delivery team approaches.
[bookmark: _Hlk107308382]

[bookmark: _Toc220570388]2 Introduction
	Queensland Health BIM objectives

	No 
	BIM objective
	Required uses of BIM by appointed parties
	BIM tiers

	1
	BIM is procured and incorporated into project delivery.
(PIR 2.1)
	From the earliest outset, a BIM Execution Plan (BEP) is to be created, based on PIR and CIR. The BEP is administered and updated by the delivery team BIM manager.
	ALL

	2
	Improving collaboration, coordination and capacity.
(PIR 2.2)
	Discipline/trade BIM/s are to be combined into a federated model and used for collaboration, and as a primary decision-making tool for coordination.
	ALL

	3
	Platform agnostic—use of openBIM formats.
(PIR 2.3)
	Both native formats and IFC are contractual deliverables at handover.
	ALL

	4
	Structured and gradual development of BIM to provide an as-built dataset.
(PIR 2.4)
	Continual development of the planning and design BIM/s to support the construction/as-built BIM/s, and any associated information requirements.
	ALL

	5
	Improved data structuring and Information coordination.
 (PIR 2.5)
	Schedule of Accommodation (SoA), drawings, schedules, Australasian Health Facilities Guidelines (AusHFG) and HHS asset coding to be coordinated and linked to BIM.
	ALL

	6
	Benefits realisation is measured and tracked.
(PIR 2.6)
	BIM benefits realisation is discussed and reported at milestone deliverables by the delivery team using the Queensland Health BIM metrics for projects.xlsx.
	ALL

	7
	Clearer design and construction comprehension.
(PIR 2.7)
	The delivery team shall leverage BIM visualisation tools (3D collaboration tools that may be supplemented with VR/AR) to help inform stakeholders of design/constructability solutions.
	ALL

	8
	Enhanced space planning. 
(PIR 2.8)
	The space planning platform (dRofus) shall be integrated with the BIM/s and used to manage functional briefing, validate SoA, room, FF+E, and asset data.
	Tier 1 + 2 only

	9
	WHS in BIM.
(PIR 2.9)
	Identified Safety in Design (SiD) risks must be navigable within the federated model to improve understanding and minimise or eliminate these risks.
	Tier 1 + 2 only

	10
	Quantity surveying from BIM.
(PIR 2.10)
	The Quantity Surveyor (QS) or cost estimator is to use design BIM/s to inform the cost planning activities, including whole-of-life costs.
	Tier 1 + 2 only

	11
	BIM to be used for operational planning and staging .
(PIR 2.11)
	The delivery team is to leverage BIM for operational planning, decanting and staging, and construction planning.
	Tier 1 only


Table 1: BIM requirements related to project scale



[bookmark: _Toc220570389]3 Overview
[bookmark: _Toc220570390]3.1 Building information modelling execution plan overview
PIR Section 2 (d and f) and 4.1. Appointed parties to nominate the BIM manager and collaboratively develop the BEP.
Refer to the Queensland Health PIR for details of:
· Responsibilities of the delivery team and BIM manager.
· Purpose of the DBEP and CBEP.
· Production, development and implementation of the DBEP and CBEP.
· Updating the DBEP and CBEP prior to the commencement of a new project stage or when a material change affects the contents of this document as per Section 4.1 of the PIR.
[bookmark: _Toc220570391]3.2 dRofus management plan overview
PIR Section 2 (e) and 3.2. Appointed parties to nominate the dRofus Lead who must then develop and continue to update the dRofus management plan.
This document must be read in conjunction with the dRofus management plan.
[bookmark: _Toc220570392]3.3 Project summary/description
[bookmark: _Hlk13143588]Refer to the DBEP. Also, PIR section 4.1 (a). Design BIM manager to insert a brief description of the project here.
[enter project description here]
[bookmark: _Toc220570393]3.4 Reference documents and shared resources
Construction BIM manager—the first table indicates the version of the TEMPLATE documents, and the second table indicates the current version of the documents used on this project, to allow for future comparison.
The current revision of the Queensland Health capital delivery documents is recorded below.
	Document
	Version
	Date

	CIR
	[enter version]
	[DD/MM/YYYY]

	Queensland Health PIR
	[enter version]
	[DD/MM/YYYY]

	DBEP template
	
	

	CBEP template
	
	

	dRofus management plan template
	
	

	Queensland Health asset equipment list
	
	[DD/MM/YYYY]

	Queensland Health BIM data uploader template
	
	

	Classification (Uniclass)
	
	

	NABERS emission factors database
	
	

	NABERS Environmental Product Declarations (EPD) codes
	
	


Table 2: Queensland Health capital delivery documents
	Document
	Version
	Date

	DBEP 
	[enter version]
	[DD/MM/YYYY]

	CBEP
	
	

	dRofus management plan
	
	

	Model content plan
	
	


Table 3: Queensland Health project documents


[bookmark: _Toc220570394]
4 Commercial
[bookmark: _Toc220570395]4.1 Procurement strategy
[bookmark: _Hlk13145122][bookmark: _Hlk13145137]The BIM manager is responsible for documenting the procurement strategy. Examples of procurement methods include:
- Managing contractor
- Design and Construct (D+C)
- Early Contractor Involvement (ECI)
- Public-Private Partnership (PPP)
If unknown, write ‘to be confirmed’. If the procurement strategy involves the designer as part of the contractor engagement, the DBEP and CBEP can be combined into one document, the design and construction BEP, using the Queensland Health templates.
[enter procurement method here]
[bookmark: _Toc16160252][bookmark: _Toc220570396]4.2 Project schedule
PIR Section 4.1 (b). The BIM manager is to complete Table 4.
The estimated dates for major project milestones, as they relate to Queensland Health project stages, are shown in Table 4.
	Project state or milestone
	Estimated start date
	Estimated completion date

	Functional design brief
	Refer to the DBEP
	Refer to the DBEP

	Masterplan
	Refer to the DBEP
	Refer to the DBEP

	Schematic design
	Refer to the DBEP
	Refer to the DBEP

	Detailed design
	Refer to the DBEP
	Refer to the DBEP

	Tender documentation
	Refer to the DBEP
	Refer to the DBEP

	Construction documentation
	Refer to the DBEP
	Refer to the DBEP

	Construction
	[DD/MM/YYYY]
	[DD/MM/YYYY] 

	Commissioning/handover
	[DD/MM/YYYY]
	[DD/MM/YYYY]

	Project evaluation
	[DD/MM/YYYY]
	[DD/MM/YYYY]


Table 4: Project schedule
[bookmark: _Toc16160253][bookmark: _Toc214011570][bookmark: _Toc220570397]4.3 Amendments to project information requirements
PIR Section 2 (g). Appointed parties to document any issues, technical or capability/capacity challenges, then seek Queensland Health project manager approval.
The following amendments to the Queensland Health PIR are proposed for this project.
	PIR clause no.
	Clause title
	Amendment

	[enter clause]
	[enter title]
	[enter change]

	
	
	

	
	
	

	
	
	


[bookmark: _Toc214011571][bookmark: _Toc16160254][bookmark: _Hlk13483644]Table 5: PIR concerns
[bookmark: _Toc220570398]4.4 Non-required uses of building information modelling (delivery team uses)
PIR Section 4.1 (e). Any non-Queensland Health required BIM uses or processes that the delivery team feel are necessary to complete the design and construction of the project (beyond those stated in the PIR) must be detailed below. This is to clearly differentiate these uses independently to the requirements of Queensland Health. Appointed parties must document any BIM use not available to Queensland Health i.e., delivery team uses only.
The following table identifies the delivery team uses of BIM unavailable to Queensland Health.
	[bookmark: _Hlk13483668]Stage
	Use
	By whom
	Comments

	Construction 
	[e.g. Structural fabrication models]
	[Steel fabricators]
	[Steel fabrication BIM/s will be produced and used for coordination but not delivered as part of the federated model. The structural engineer’s BIM/s will be updated to as-built and included in the federated model].

	Commissioning/ handover
	[enter use]
	[enter party]
	[enter context]


Table 6: Delivery team uses of BIM (not required by Queensland Health)
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AI-generated content may be incorrect.]
[bookmark: _Toc16160255][bookmark: _Toc214011572][bookmark: _Toc220570399][bookmark: _Hlk109304257]4.5 Delivery team
PIR Section 4.1 (g). The BIM manager is to complete the table below and add other disciplines/trades as necessary. If this table is completed pre-tender, write ‘TBA’ against the unknown consultants/trades. Add extra delivery team members as necessary when known and include their BIM approaches in all updates to the CBEP, for Queensland Health approval. 
List the QS, including whether this role sits with the client, contractor, or a novated design consultant. Where not yet known, write ‘TBA’.
The contact details for key stakeholders involved in planning and managing BIM on this project are detailed in Table 7.
	Role
	Discipline
	Name
	Company
	Email/phone

	QS
	Cost planning
	[refer to DBEP as applicable]
	[refer to DBEP as applicable]
	[refer to DBEP as applicable]

	BIM manager
	BIM
	
	
	

	dRofus lead
	Space planning
	
	
	

	Civil engineer
	Civil
	
	
	

	Architectural BIM lead
	Architecture
	[refer to DBEP as applicable]
	[refer to DBEP as applicable]
	[refer to DBEP as applicable]

	Structural BIM lead
	Structure
	[refer to DBEP as applicable]
	[refer to DBEP as applicable]
	[refer to DBEP as applicable]

	Mechanical trade BIM lead
	Mechanical
	
	
	

	Hydraulic trade BIM lead
	Hydraulic 
	
	
	

	Electrical trade BIM lead
	Electrical
	
	
	


Table 7: Key project team members
[Enter project title]	Page 21[image: A white logo with a black background
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[bookmark: _Toc220570400]5 Management
[bookmark: _Hlk13237255][bookmark: _Ref4074275]The following sections detail the collaboration and communication procedures for local and remote users to access and use BIM for decision-making. The delivery team’s BIM manager is responsible for ensuring all deliverables listed in this section are successfully produced.
[bookmark: _Toc16160257][bookmark: _Toc214011574][bookmark: _Toc220570401][bookmark: _Hlk5116620]5.2 Project location and set out
[bookmark: _Hlk13237322]Refer to the DBEP for established values 
PIR Section 4.5 states that the BIM manager must nominate a master coordinates file and record the project coordinates in the table below.
Master coordinates file name: [enter master coordinates file name here]
	[bookmark: _Hlk5116808]Attribute
	Details

	Geodetic datum
	[enter the horizontal datum used for survey control (must be GDA2020)]

	Projection/CRS
	[enter the projected coordinate system and EPSG code (e.g. MGA Zone 56, EPSG:7856)]

	Height datum
	[enter the vertical datum used for elevation (e.g. AHD71)]

	Permanent survey marker (PSM)
(or equivalent known survey point)
	[enter the name and coordinates of the known site survey point]
Name: 
N/S (Y): 
E/W (X): 
Elevation (Z): 

	Project base point
(e.g. local grid intersection)
	[Enter the location of the project base point coordinates]
Location: 
N/S (Y): 
E/W (X): 
Elevation (Z): 

	Project location description
	[enter the project’s general location using cardinal directions from a known place]

	Model rotation
	[enter the angle in degrees, clockwise from true north to project north]

	Coordinate units (m or mm)
	[enter the units of the coordinate values]


[bookmark: _Toc16160258][bookmark: _Ref106972531][bookmark: _Toc214011575]Table 8: Model geographic location 
[bookmark: _Toc220570402]5.2 Building information modelling coordination meetings
[bookmark: _Hlk13237545]PIR Section 4.3
The following table specifies the BIM meetings, timings, and location.
	Meeting
	Timings
	Location

	Construction BIM execution planning
	2 weeks after contract award
	[populate]

	Safety in design workshop
	[enter as per project delivery schedule]
	[populate]

	3D coordination/clash resolution
	[minimum fortnightly]
	[populate]

	3D design review meetings
	[minimum fortnightly]
	[populate]

	Information requirements planning (with HHS)
	Before physical construction begins and during handover
	[populate]


[bookmark: _Toc206401278][bookmark: _Toc206401279][bookmark: _Ref4076100][bookmark: _Toc16160259][bookmark: _Toc214011576]Table 9: Meetings
[bookmark: _Toc220570403]5.3 User group and stakeholder communication processes
[bookmark: _Hlk13237931]Refer to the DBEP for the design stakeholder strategy. Also, PIR Section 4.1 (h) and 2.7.
The user group and stakeholder communication processes (including the use of the BIM for staging, decanting and operational planning) are documented below.
[bookmark: _Ref14684218][bookmark: _Toc16160260][bookmark: _Ref106966606][bookmark: _Toc214011577] [enter stakeholder strategy here]


     Building information modelling requirements by project stages

[bookmark: _Toc220570404]5.4 Existing conditions modelling
[bookmark: _Hlk13238801]PIR Section 3.3. Appointed parties to document any previous HHS existing conditions information (2D drawings), new survey and the extents of existing conditions to be modelled.
Refer to the DBEP.
[bookmark: _Toc214011578][bookmark: _Toc220570405][bookmark: _Hlk13484763]5.5 Design modelling
[image: ]
For project planning through to tender evaluation and award, refer to the project DBEP.
[bookmark: _Ref107848294][bookmark: _Toc214011579][bookmark: _Toc220570406]5.6 Construction delivery
[image: ]
PIR section 3.10
5.6.1 Overview
Where BIM/s from earlier stages are not available, incomplete, or non-compliant with the DBEP, the contractor must ensure that these requirements are fulfilled during this stage and incorporated into the final information deliverables.
BIM/s completed during construction delivery shall form the basis for documentation suitable for fabrication and assembly. From construction onwards, the BIM/s must contain the requirements of all previous project stages as nominated in the DBEP and incorporate the following:
a) The extent of subcontractors, fabricators and suppliers developing BIM/s shall be agreed between Queensland Health and the delivery team to suit the HHS requirements of as-builts. All required modelling shall be a continuation and development of the design intent models; as such, all requirements documented in the DBEP and PIR shall apply.
b) Throughout construction, modifications may be made to the project because of procurement, cost, material and/or equipment selection or constructability issues. Where these changes are within the scope of the project, these changes must be coordinated with the design BIM/s and documented in the workshop/fabrication models (if created).
c) At the end of construction, there must be limited spatial coordination issues, and all applicable workshop detailing information should be coordinated and incorporated.
d) Procurement, fabrication, and construction will commence within this project stage.
e) Design and construction subcontractors may prepare workshop models in 3D software packages approved for use by Queensland Health; however, they must provide models in their native format and IFC exports for coordination.
f) Where developing model elements further (from design stages) to include finish and/or manufacturer data, the existing generalised model elements should be modified by enhancing the component, not deleting it and replacing it, which would erase the underlying data.
g) Integration and synchronisation of the BIM/s with the space planning tool or database must be continued from the design stages, to support the provision of coordinated as-built, asset, and Furniture, Fixture and Equipment (FF+E) information during handover.
h) [bookmark: _Hlk13489805]All instances of model elements in a service run must be allocated to a defined system.
i) All parameters relevant to construction shall be populated in the BIM/s as per Section 4.14 of the PIR by each model element author as required.
j) A federated model, built from IFC format trade/discipline BIM/s, delivered in the agreed format (as agreed per project), at the Construction stage, is to be used for coordination and made available and readily accessible to Queensland Health.
k) The CBEP shall continue the QS modelling requirements established in the DBEP.
l) [Enter additional delivery team items here].
[bookmark: _Toc465961125][bookmark: _Hlk13577079]5.6.2 Architectural building information modelling
All other elements not mentioned below that the delivery team identifies as being required to complete deliverables for this stage must be agreed and a documented approach specified in the CBEP section below.
For construction onwards, the BIM/s must contain the architecture requirements of the DBEP and:
a) Review and revise the BIM/s and dRofus project database for any Queensland Health-approved request for information or technical query from the workshop detailers.
b) Incorporate any Queensland Health-approved revisions to the BIM/s and model elements due to coordination issues with the fabrication models and/or installation process.
c) Incorporate any Queensland Health-approved revisions to the BIM/s, model elements and space planning tool due to procurement approaches.
d) [enter additional delivery team items here].
[bookmark: _Toc465961126][bookmark: _Hlk13577263]5.6.3 External façade building information modelling
All other elements not mentioned below that the delivery team identifies as being required to complete deliverables for this stage must be agreed and a documented approach specified in the CBEP section below.
In coordination with the architect and structural consultant, the subcontractor shall develop BIM/s incorporating all of the following:
a) Fabrication elements.
b) Fixing elements connecting façade to structure.
c) Any additional elements that are considered required for coordination.
d) [enter additional delivery team items here].
If the appointed subcontractor does not have the capability to further develop the BIM/s, then the contractor must arrange for the architect, at the contractor’s cost, to incorporate the details above.
[bookmark: _Toc447286281][bookmark: _Toc465961127]5.6.4 Structural building information modelling
All other elements not mentioned below that the delivery team identifies as being required to complete deliverables for this stage must be agreed and a documented approach specified in the CBEP section below.
For construction onwards, the BIM/s must contain the structural requirements of the design BIM Execution Plan and:
a) Prepare and send the model data to the structural steel workshop detailer as the basis of the workshop model. This model data is to be sent as BIM/s and drawings.
b) Review and revise the structural BIM/s for any Queensland Health-approved request for information or tender query from the workshop detailers. Incorporate any Queensland Health-approved revisions to the structural BIM/s and model elements due to coordination issues with the fabrication models and/or installation process.
c) Incorporate any Queensland Health-approved revisions to the structural BIM/s and model elements due to procurement approaches.
d) Incorporate any approved changes to the designed systems from the workshop model.
e) [enter additional delivery team items here].
[bookmark: _Toc465961128]5.6.5 Precast concrete
All other elements not mentioned below that the delivery team identifies as being required to complete deliverables for this stage must be agreed and a documented approach specified in the CBEP section below.
The subcontractor shall develop a 3D model incorporating all of the following:
a) Structural precast elements shall be modelled as individual discrete constructed elements, depicted to the exact height, length, width and ratings (fire) and containing all required sleeves and penetration to properly reflect precast element types. All precast elements shall be modelled with the necessary intelligence to produce accurate precast schedules.
b) All precast concrete stairs and landings, and necessary openings and framing members for stair systems shall be depicted to the exact height, length, width and ratings (fire).
c) All necessary precast shafts, pits, sumps and openings, including necessary intelligence to produce accurate plans and building/wall sections depicting these design and constructed elements.
d) All miscellaneous steel, including angles for panel openings, panel bearing and channels for mechanical, shall be modelled.
e) [enter additional delivery team items here].
If the appointed subcontractor does not have the capability to further develop the BIM/s, then the contractor must arrange for the Structural consultant, at the contractor’s cost, to incorporate the details above.
[bookmark: _Toc465961129]5.6.6 Structural steel subcontractor
All other elements not mentioned below that the delivery team identifies as being required to complete deliverables for this stage must be agreed and a documented approach specified in the CBEP section below.
The subcontractor shall develop a 3D model depicting the structural steel scope of work, incorporating all of the following:
a) Actual elevations and location of member connections.
b) Large elements of typical connections applied to all structural steel connections, such as base plates, gusset plates, cleat plates and anchor rods.
c) Joist bridging and lateral braces.
d) Fire protection coating.
e) Any miscellaneous steel pertaining to the joist.
f) Joist seat width.
g) Erection details for installation.
h) Chord and web member section profiles are defined.
i) Joist layout in coordination with metal deck fasteners confirmed.
j) Non-standard joist seat depths and/or sloping joist seat.
k) Any miscellaneous steel members with the correct size and orientation.
l) Any steel structure reinforcement, such as web stiffeners, sleeve penetrations.
m) All assembly elements.
n) The model will represent an ‘as fabricated’, fully detailed level of information.
o) The model/s shall include necessary intelligence to reflect accurate quantities by trade type (steel).
p) [enter additional delivery team items here].
All trade models shall be updated and maintained to reflect changes in the work as a result of coordination or design/construction changes and shall be delivered at the end of the project as an ‘as-built’ record model of the structural systems in its entirety.
[bookmark: _Toc352243493][bookmark: _Toc465961130]5.6.7 Mechanical subcontractor
All other elements not mentioned below that the delivery team identifies as being required to complete deliverables for this stage must be agreed and a documented approach specified in the CBEP section below.
The subcontractor shall develop a 3D model incorporating all of the following systems:
a) Supply, return, exhaust, relief and outside air ductwork, including any insulation modelled to outside face dimension or duct insulation (whichever is greater). Insulation shall be separately indicated as a semi-transparent thickness around the pipework.
b) All ductwork and pipework modelled in fabricated lengths incorporating flanges, joints, other connectors, etc.
c) All equipment installed in the mechanical scope of work (including fans, air handling units, built-up air handling units, pumps, tanks, valves, controls, heat exchangers, smoke and fire dampers).
d) Incorporate vendor model elements for equipment when selected. If used, these model elements must have the ability to carry the required information requirements.
e) All valves (including valve stems and handles), gauges and control valves.
f) Pipes sized at and over 15mm diameter, including any insulation.
g) Diffusers, registers, louvres, grilles, high and low point drains, starters, etc.
h) All equipment installed in the respective scopes of work.
i) Hangers and seismic bracing for normal, emergency and isolated power systems or applicable specialty systems and structural supports, including strong-back angles and uni-strut supports where required.
j) Acoustic and fire-rated collars and dampers.
k) Concrete equipment pads, inertia pads.
l) Clearance zones for access, service space requirements, gauge reading, valve clearances and other operational clearances must be modelled as part of the mechanical equipment for coordination/constructability reviews.
m) Access doors and panels, including access zones in front, above and below, shall be modelled and comply with accessibility requirements for items listed above for code and maintenance purposes.
n) The BIM/s shall include the necessary intelligence to reflect accurate quantities by type of building services.
o) [enter additional delivery team items here].
All trade models shall be updated and maintained to reflect changes in the work as a result of coordination or design changes and shall be delivered at the end of the project as an ‘as-built’ record model of the mechanical system in its entirety.
[bookmark: _Toc465961131]5.6.8 Medical gas subcontractor
All other elements not mentioned below that the delivery team identifies as being required to complete deliverables for this stage must be agreed and a documented approach specified in the CBEP section below.
The subcontractor shall develop a 3D model incorporating all of the following medical gas systems, including but not limited to:
a) All medical gas systems, equipment and devices, modelled to overall height, width and depth.
b) All pipework modelled in fabricated lengths incorporating flanges, joints, other connectors, etc.
c) Plant room equipment such as generators, manifolds and compressors.
d) Pipe information, including size, type, and insulation needs. Insulation shall be separately indicated as a semi-transparent thickness around the pipework.
e) All valves (including valve stems and handles), gauges and control valves, solenoids/emergency shut-off valves and information such as operation method, etc.
f) Bracket and support details.
g) Acoustic and fire-rated collars and dampers.
h) Nist connection plate details.
i) Outlet information.
j) Control and indicator panels.
k) All equipment installed in their respective scope of work.
l) Clearance zones for access, service space requirements, gauge reading, valve clearances and other operational clearances must be modelled as part of the medical gas equipment for coordination/constructability reviews.
m) Access doors and panels, including access zones in front, above and below, shall be modelled and comply with accessibility requirements for items listed above for code and maintenance purposes.
n) The BIM/s shall include the necessary intelligence to reflect accurate quantities by type of building services.
o) [enter additional delivery team items here].
All trade models shall be updated and maintained to reflect changes in the work as a result of coordination or design changes and shall be delivered at the end of the project as an ‘as-built’ record model of the medical gas system in its entirety.
[bookmark: _Toc352243495][bookmark: _Toc465961132]5.6.9 Electrical subcontractor
All other elements not mentioned below that the delivery team identifies as being required to complete deliverables for this stage must be agreed and a documented approach specified in the CBEP section below.
The subcontractor shall develop a 3D model incorporating all of the following systems:
a) All electrical systems, equipment and devices, modelled to overall height, width and depth.
b) All cable containment and fittings (cable tray/ladder/ducting).
c) All conduits 15mm or larger.
d) Acoustic and fire-rated collars and dampers.
e) All equipment installed in the respective scopes of work, panels, transformers, switch/paralleling gear, automatic transfer switch, generators, starters, variable frequency drive.
f) Hangers and seismic bracing for normal, emergency and isolated power systems or applicable specialty systems and structural supports, including strong-back angles and uni-strut supports where required.
g) Light fixtures, exit signs, recessed electrical devices, speakers, AV equipment and devices, modelled and coordinated with ceilings and walls and incorporating access clearances or zones required for maintenance.
h) Concrete equipment pads, inertia pads.
i) All electrical components must be assigned to an electrical switchboard.
j) Creation of panel schedules is mandatory, within the model authoring tool, for all electrical components.
k) Clearance zones for access, service space requirements, gauge reading, valve clearances and other operational clearances must be modelled as part of the electrical equipment for coordination/constructability reviews.
l) Access doors and panels, including access zones in front, above and below, shall be modelled and comply with accessibility requirements for items listed above for code and maintenance purposes.
m) [bookmark: _Hlk14789546]The BIM/s shall include the necessary intelligence to reflect accurate quantities by type of building services.
n) [enter additional delivery team items here].
All trade models shall be updated and maintained to reflect changes in the work as a result of coordination or design changes and shall be delivered at the end of the project as an ‘as-built’ record model of the electrical system in its entirety.
[bookmark: _Toc352243496][bookmark: _Toc465961133]5.6.10 Information and communication technology and security
All other elements not mentioned below that the delivery team identifies as being required to complete deliverables for this stage must be agreed and a documented approach specified in the CBEP section below.
The subcontractor shall develop a 3D model incorporating all of the following systems:
a) All cable containment and fittings (cable tray/ladder/ducting).
b) All conduits 15mm or larger.
c) Acoustic and fire-rated collars and dampers.
d) Speakers, AV equipment and devices.
e) Clearance zones for access, service space requirements, gauge reading, valve clearances and other operational clearances must be modelled as part of the ICT and security equipment for collision checking.
f) The BIM/s shall include necessary intelligence to reflect accurate quantities by type of building services.
g) All other elements not mentioned above that the capital consultants identify as being required to complete deliverables for the part must be set out, and a documentation approach specified in this CBEP.
h) [enter additional delivery team items here].
All trade models shall be updated and maintained to reflect changes in the work as a result of coordination or design changes and shall be delivered at the end of the project as an ‘as-built’ record model of the ICT and security system in its entirety.
[bookmark: _Toc352243497][bookmark: _Toc352243498][bookmark: _Toc352243499][bookmark: _Toc352243500][bookmark: _Toc352243501][bookmark: _Toc352243502][bookmark: _Toc352243503][bookmark: _Toc352243504][bookmark: _Toc352243505][bookmark: _Toc352243506][bookmark: _Toc465961134]5.6.11 Fire protection subcontractor
All other elements not mentioned below that the delivery team identifies as being required to complete deliverables for this stage must be agreed and a documented approach specified in the CBEP section below.
The subcontractor shall develop a 3D model incorporating all of the following systems:
a) Risers, main and branch piping, including sprinkler lines from a diameter of 15mm and over.
b) Pumps, controllers, automatic transfer switch and equipment installed in the fire protection system scope of work.
c) All sprinkler heads, detectors, alarms and public address systems.
d) All valve assemblies, gauges and control valves, drain valves and fire department connections, including valve clearances.
e) Insulation on piping if required. Insulation shall be separately indicated as a semi-transparent thickness around the pipework.
f) Fire alarm components and devices.
g) Acoustic and fire-rated collars and dampers.
h) Hangers and seismic bracing, and structural supports, including strong-back angles and uni-strut supports where required.
i) Concrete equipment pads, inertia pads.
j) Clearance zones for access, service space requirements, gauge reading, valve clearances and other operational clearances must be modelled as part of the Fire Protection equipment for coordination/constructability reviews.
k) Access doors and panels, including access zones in front, above and below, shall be modelled and comply with accessibility requirements for items listed above for code and maintenance purposes.
l) The BIM/s shall include the necessary intelligence to reflect accurate quantities by type of building services.
m) [Enter additional delivery team items here].
All trade models shall be updated and maintained to reflect changes in the work as a result of coordination or design changes and shall be delivered at the end of the project as an ‘as-built’ record model of the fire protection system in its entirety.
[bookmark: _Toc352243507][bookmark: _Toc465961135]5.6.12 Hydraulics subcontractor
All other elements not mentioned below that the delivery team identifies as being required to complete deliverables for this stage must be agreed and a documented approach specified in the CBEP section below.
The subcontractor shall develop a 3D model incorporating all of the following systems:
a) All piping systems (sized at and over 15mm diameter), including insulation. Insulation shall be separately indicated as a semi-transparent thickness around the pipework.
b) All equipment installed in the plumbing scope of work, (including domestic water, chilled water, steam, storm/roof leaders, pumps, tanks, water heaters, in-wall carriers, in-wall plumbing equipment.
c) Fixtures: sinks, toilet fixtures, water tanks, floor sinks.
d) Note: plumbing fixtures and fittings should preferably be ‘copy/monitored’ through the architectural link. The Hydraulic BIM/s should at least contain a connection point family aligned to the fixture within the architectural model.
e) All valves, gauges and control valves.
f) Clean-outs.
g) Acoustic and fire-rated collars and dampers.
h) Hangers and seismic bracing, and structural supports, including strong-back angles and uni-strut supports where required.
i) Clearance zones for access, service space requirements, gauge reading, valve clearances and other operational clearances must be modelled as part of the Hydraulic equipment for coordination/constructability reviews.
j) The BIM/s shall include the necessary intelligence to reflect accurate quantities by type of building services.
k) [enter additional delivery team items here].
All trade models shall be updated and maintained to reflect changes in the work as a result of coordination or design changes and shall be delivered at the end of the project as an ‘as-built’ record model of the plumbing and hydraulics system in its entirety.


[bookmark: _Toc352243508]5.6.13 Construction dRofus database
All other elements not mentioned below that the delivery team identifies as being required to complete deliverables for this stage must be agreed and a documented approach specified in the CBEP section below.
dRofus must be used by all disciplines/trades, in accordance with the dRofus management plan, to the fullest extent practicable to:
Create and manage design and building data, and BIM intelligence.
Produce non-drawing-based deliverables required in this project stage.
In Construction, this includes:
a) Preparation of handover and commissioning reports, asset lists and information requirements required for delivery at the end of construction.
b) Maintenance of FF+E and mechanical equipment schedules, selections and related installation and commissioning data.
c) Maintenance of space and room naming data synchronised between the BIM and trade models and space planning tool or database.
d) Building fabric schedules, e.g. signage schedules, AV schedules.
e) [enter additional delivery team items here].


5.6.14 Construction building information modelling deliverables
The discipline/trades in Section 5.6 must product BIM/s or 3D models that reflect the design/construction intent and be capable of integration with the workshop-level trade/fabrication models. The BIMs will accurately represent the design and construction solution by the end of construction, incorporating all of the following elements: 
a) All BIM/s, fabrication/trade models are to be delivered/exchanged to Queensland Health in the agreed open standard IFC 4 (or later) format (if multiple models are being used, please share as transmittal package, e.g. eTransmit).
b) All IFC models to contain all Queensland Health asset parameters mapped to their respective QH_Information property sets.
c) A federated model, built from IFC format trade/discipline BIM/s, delivered in the agreed format (as agreed per project)
d) All model elements submitted are to be compatible and editable within the native BIM authoring tools. No model elements shall be stripped of data, and all drawings and schedules should remain and reference the model elements and, where applicable, dRofus.
e) BIM/s and dRofus project database synchronised prior to extracts and delivery.
f) [bookmark: _Hlk13577003]All separately required deliverables related to the HHS asset management and maintenance system input requirements (as defined in the PIR/DBEP) are to be met, regardless of the BIM requirements for the project.
g) Electronic drawing, space planning information database and models are to be provided to Queensland Health on a hard drive as applicable unless otherwise agreed (e.g. by web file transfer or similar).
h) Asset data extracted from BIM into the Queensland Health BIM data uploader template.xlsx and consolidated for all disciplines by the BIM manager.
i) Project stage-specific BIM benefits realisation metrics shall be documented in Queensland Health BIM metrics for projects.xlsx template.

5.6.15 Building information audit
Audits of all BIM files (including dRofus) for the project will be undertaken by Queensland Health BIM advisor/s during Construction. The advisor/s will assess the federated model to ensure alignment with the DBEP/CBEP and PIR. The Queensland Health BIM data uploader template.xlsx shall be checked for compliant information requirements, and the
Queensland Health BIM metrics for projects.xlsx shall be completed. A report with actions will be produced, and the delivery team will have a nominated time horizon to remedy any deficiencies. Any errors or omissions will need to be remedied by the originating authors and managed by the Construction BIM manager.
0. [bookmark: _Toc214011580][bookmark: _Toc220570407]Commissioning and handover
[image: ]
5.7.1 Overview
[bookmark: _Hlk13580123]PIR Section 3.11. Contractor to detail below the methodologies/collaborative software platforms to be used to create and collate asset management and as-built information.
As-built models
Define the type of as-built model required. For example:
 - As documented plus approved changes during construction, verified by;
 - As surveyed (on-site by scanning, etc.)
 - Visually, evidenced through photo overlay or photogrammetry.
Define or refer to the data required for FM purposes, e.g. Section 6.4.
State the purpose for which the BIM/s are to be used and define the dimensional accuracy required.
Asset information for facilities management
The strategy for the collection of HHS asset data at the commissioning and handover stage will be shaped by decisions made earlier in the project, e.g.:
Scenario 1—additional project-specific HHS critical asset information has been specified in the PIR/DBEP/CBEP: In this instance, confirm with the HHS and Queensland Health that this still meets their requirements. If not, determine what their revised requirements are and agree on an appropriate response.
Scenario 2 —no additional project-specific HHS asset data is required, just the minimum requirements set out in the PIR: In this instance, establish if the defined information is populated as required.
Whichever scenario applies, it should be confirmed/agreed and documented in the CBEP.
Describe the format for integrating additional project-specific HHS critical asset information.
e.g., new tab on the Queensland Health BIM data uploader template
Describe the method of recording and exchanging information, e.g. spreadsheets,
Describe who will be responsible and outline procedures for capturing and recording information and verifying its correctness, including sign-off protocols.
For As-Built, the BIM/s must contain the requirements of all previous project stages, updated to capture the relevant commissioning information requirements data and reflect the completed works to an as-built status.
[enter details here]
5.7.2 Model verification
PIR 3.11. In this section, document the as-built model verification process. This may consist of a measured approach using laser scanning, or a visually verified approach using photogrammetry, 360 photos, or photos.
[enter details here]
5.7.3 Commissioning and handover dRofus database
All other elements not mentioned below that the delivery team identifies as being required to complete deliverables for this stage must be agreed and a documented approach specified in the CBEP section below.
dRofus must be used by all disciplines/trades, in accordance with the dRofus Management Plan, to the fullest extent practicable to:
Manage and complete design and building data, and BIM intelligence.
Deliver non-drawing-based deliverables required in this project stage.
In Commissioning and Handover, this includes:
a) Completion of handover and commissioning reports, asset lists and information requirements required for delivery at the end of construction.
b) Completion of FF+E and mechanical equipment schedules, selections and related installation and commissioning data.
c) Completion of Space and room naming data synchronised between the BIM and trade models and space planning tool or database.
d) Building fabric schedules, e.g. signage schedules, AV schedules.
e) [enter additional delivery team items here].

5.7.4 As-built building information modelling deliverables
The contractor must prepare and supply asset management and as-built information as detailed in the construction contract preliminaries, Queensland Health PIR, DBEP + CBEP, and CIR, and any documents referenced therein, such as the Queensland Health BIM metrics for projects.xlsx template, Queensland Health asset equipment lists.xlsx, or Queensland Health BIM data uploader template.xlsx, including:
a) Discipline-centric BIM/s in both native and IFC formats, incorporating all elements nominated in the PIR, DBEP and CBEP (if multiple models are being used, please share as transmittal package, e.g. eTransmit).
b) A federated model, built from IFC format trade/discipline BIM/s, delivered in the agreed format (as agreed per project).
c) BIM/s and dRofus project database synchronised prior to extracts and delivery.
d) All IFC models to contain all Queensland Health asset parameters mapped to their respective QH_Information property sets.
e) Asset data extracted from BIM into the Queensland Health BIM data uploader template.xlsx template and consolidated for all disciplines by the BIM manager.
f) Project stage-specific BIM benefits realisation metrics shall be documented in Queensland Health BIM metrics for projects.xlsx template.
g) Queensland Health sustainability spreadsheet.xlsx containing embodied carbon data for all applicable elements (concrete, steel, aluminium, glass), according to PIR section 4.14.9.

h) All other handover contract deliverables, including O+Ms, in a searchable digital format, referenced as agreed with the HHS. 
5.7.5 Building information modelling audit
An Audit of all BIM files (including dRofus) for the project will be undertaken by Queensland Health BIM advisor/s before the as-built handover. The advisor/s will assess the federated model to ensure alignment with the DBEP/CBEP and PIR. The Queensland Health BIM data uploader template.xlsx shall be checked for compliant information requirements, and both the Queensland Health BIM metrics for projects.xlsx and Queensland Health sustainability spreadsheet.xlsx shall be validated. A report with actions will be produced, and the delivery team will have a nominated time horizon to remedy any deficiencies. Any errors or omissions will need to be remedied by the originating authors and managed by the construction BIM manager.


[bookmark: _Toc220570408]6 Technical 
[bookmark: _Hlk5117139][bookmark: _Hlk13483635]The following section outlines the expected uses for BIM on the project, aligned to the PIR. Changing uses of BIM during the project changes the scope of service previously agreed and documented and has contractual implications. To reduce the risk of disputes, manage changes in conformance with the terms and conditions in agreements and contracts and keep a cumulative record of agreed changes in a constant location, e.g. the BEP. Each version of the BEP should highlight changes approved since the issue of the previous version.
[bookmark: _Toc16160284][bookmark: _Toc214011582][bookmark: _Toc220570409]6.1 Software selection
[bookmark: _Hlk13238364]PIR Section 2.3, 4.6, 4.7 - 4.11. Add other delivery team members and software as necessary.
The chosen (buildingSMART IFC-certified) BIM authoring tools are recorded in Table 10. Once endorsed by the delivery team, use of different versions is not permitted without approval from the nominated 
Queensland Health representative.
	Disciplines
	Software (version/build)
	Use

	Cost planning 
	[enter]
	Costing

	Civil
	[enter]
	Design authoring

	Architecture
	[enter]
	Design authoring

	Façade 
	[enter]
	Design authoring

	Structure
	[enter]
	Detailing and fabrication

	Precast concrete
	[enter]
	[enter]

	Steel fabricator
	[enter]
	[enter]

	Mechanical trade
	[enter]
	[enter]

	Electrical trade
	[enter]
	[enter]

	ICT + security trade
	[enter]
	[enter]

	Fire protection trade
	[enter]
	[enter]

	Hydraulic trade
	[enter]
	[enter]

	[enter specialist trades]
	[enter]
	[enter]

	Scheduling/programming
	[enter]
	[enter]

	Cost estimating
	[enter]
	[enter]

	Specifications
	[enter]
	[enter]

	Delivery team collaboration
	[enter]
	Model collaboration

	Delivery team collaboration
	[enter]
	Document management system

	Delivery team coordination
	[enter]
	Clash detection/avoidance

	Delivery team coordination
	[enter]
	Issue tracking


[bookmark: _Toc16160293][bookmark: _Toc214011583][bookmark: _Hlk13237806]Table 10: Software selection
[bookmark: _Toc220570410]6.2 Project common data environment
[bookmark: _Hlk13237821]PIR Section 2, 4.13 nominates the project CDE for desin and how access will be managed for
Queensland Health representatives.
[enter CDE details here or refer to the relevant document]
[bookmark: _Toc16160294]6.2.1 Information status, revision and classification
[bookmark: _Hlk13237901]Document the proposed approach to managing the information containers held within the CDE, including status (concept, SD, DD, CD, IFC), revision (1, 2, 3, and A, B, C, etc.), and information container classification. Check the Aconex guide if relevant
[enter details here]
[bookmark: _Toc16160295]6.2.2 Information containers
[bookmark: _Hlk13237915]PIR Section 4.4. Appointed parties to document the information containers graphically showing the relationships, e.g. cost plan, discipline BIM/s versus trade models and the federated model, interaction with the CDE, etc. Check the Aconex guide if relevant
The diagram below identifies the high-level information delivery plan and the associated information containers.
[enter diagram here]
[bookmark: _Toc16160296]6.2.3 Collaboration resources
Detail how to request access, uses of each system/platform, etc., below.
The details of the project’s collaboration resources are documented below.
[enter details here]
6.2.4 Exchange frequency
Use this section to define a table showing model element authors, model formats (native, IFC, etc.), frequency of exchange (e.g. weekly, milestone, etc.)
[enter details here]
	Disciplines/trades
	Weekly collaboration (native formats)
	Fortnightly HIQ submission (IFC format)
	Project stage milestones (native and IFC formats)

	Federated model
	[enter – e.g. upload to cloud model collaboration tool, Issue tracking, etc.]
	[enter – e.g. upload to cloud model collaboration tool, etc.]
	[enter – e.g. upload to cloud model collaboration tool, Issue tracking, Aconex, etc.]

	Civil
	[enter]
	[enter]
	[enter]

	Architecture
	[enter]
	[enter]
	[enter]

	Façade 
	[enter]
	[enter]
	[enter]

	Structure
	[enter]
	[enter]
	[enter]

	Precast concrete
	[enter]
	[enter]
	[enter]

	Steel fabricator
	[enter]
	[enter]
	[enter]

	Mechanical trade
	[enter]
	[enter]
	[enter]

	Electrical trade
	[enter]
	[enter]
	[enter]

	ICT + security trade
	[enter]
	[enter]
	[enter]

	Fire protection trade
	[enter]
	[enter]
	[enter]

	Hydraulic trade
	[enter]
	[enter]
	[enter]

	[enter specialist trades]
	[enter]
	[enter]
	[enter]


Table 11: Model exchange frequency


[bookmark: _Toc220570411][bookmark: _Toc214011584]6.3 Industry foundation classes
PIR Section 4.11 describes the IFC requirements for the project.
6.3.1 Export settings: Revit to industry foundation classes
The steps below outline the process to deliver an Industry Foundation Classes (IFC) format BIM from Autodesk Revit. Other authoring tools should follow the same principles regarding mapping
Queensland Health BIM Shared Parameters to QH_Information IFC property sets as defined in Section 6.4.1.
[image: A screenshot of a computer
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[bookmark: _Ref107385975][bookmark: _Ref107385964]Figure 1: Exporting IFC from Revit
In the relevant 3D export view in Revit (refer to Figure 1: exporting IFC from Revit (1) figure 1):
1) Select File.
2) Select Export.
3) Select IFC.
4) Select Modify setup.

[image: A screenshot of a computer

AI-generated content may be incorrect.]
[bookmark: _Ref107386698]Figure 2: Exporting IFC from Revit
In the ‘Modify Setup’ dialogue box (refer to Figure 2):
1) Select the property sets tab, ensure relevant tick boxes are checked.
2) Browse to and select the Queensland Health IFC export mapping file.
3) Click ‘Ok’ and export as usual.
Other settings may be adjusted as required, but the result shall be all Queensland Health BIM shared parameters being successfully mapped to the relevant Queensland Health_Information property set tab in IFC (refer to Figure 3).

[image: A screenshot of a computer

AI-generated content may be incorrect.]
[bookmark: _Ref210821811]                                       Figure 3: Example IFC showing QH_Information Property Set tab

[bookmark: _Ref106986560][bookmark: _Toc195787245][bookmark: _Toc214011585][bookmark: _Toc220570412]6.4 Information requirements
Queensland Health recognises that during delivery, it may not be practical for project teams to store data in model environments. As such, it is up to the delivery team to determine and document in the BEP how they intend to distribute, collate and verify required asset data.
This section focuses on the alphanumerical (non-geometric) component of the ‘Level of Information Need’, specifically the structured data that must be attributed to modelled elements within the BIM/s.
The PIR outlines the authoritative source of Queensland Health’s information requirements, including asset groupings, classification, functional location numbering, room codes and attribution at each project stage.
The delivery team shall refer directly to the PIR to determine the specific attributes and classifications applicable to each element or asset group. Also see the Queensland Health asset equipment lists for greater detail and the BIM data uploader for source lists.
[enter here]
[bookmark: _Ref206495437]6.4.1 Attributes
Queensland Health has prefixed all parameter names with QH_ as they relate directly to Queensland Health's needs. These parameters are available preconfigured for the project environment in Autodesk Revit 2024. It is understood that not all designers use this BIM authoring tool, and it is hoped that future versions may provide preconfigured parameters for other applications if requested.
Schedules for each asset group have been provided in the Queensland Health project schedules (Revit)_2024.rvt file and should be copied into each model using the instructions contained in the file.
All shared parameters provided in the Queensland Health Shared Parameter and Queensland Health dRofus Shared Parameter file must be used to create shared parameters in Autodesk Revit. The Global Unique Identifier (GUID) of the project shared parameter shall match the GUID in the QH provided TXT files.
[image: Text, letter

Description automatically generated]
Figure 4: Adding parameters and exporting asset schedules
If these documents aren’t compatible with selected BIM authoring tools, use the attributes by grouping tab in the Queensland Health asset equipment lists spreadsheet to configure the parameters.
6.4.2 Hospital and health service, building, floor/level and zoning naming
PIR section 4.1 (m). Appointed parties shall use HHS coding. Engage with the relevant Queensland Health representative to obtain the necessary details, such as Functional Location Code values, level naming, etc., at the beginning of the project.
[enter here]


[bookmark: _Toc206401358][bookmark: _Toc206401359][bookmark: _Toc206401360][bookmark: _Toc206401361][bookmark: _Toc206401362][bookmark: _Toc206401363][bookmark: _Toc206401364][bookmark: _Toc206401365][bookmark: _Toc206401366][bookmark: _Toc206401367][bookmark: _Toc206401368][bookmark: _Toc206401369][bookmark: _Toc206401370][bookmark: _Toc206401371][bookmark: _Toc206401372][bookmark: _Toc206401373][bookmark: _Toc206401374][bookmark: _Toc206401375][bookmark: _Toc206401376][bookmark: _Toc206401377][bookmark: _Toc206401378][bookmark: _Toc206401379][bookmark: _Toc206401380][bookmark: _Toc206401381][bookmark: _Toc206401382][bookmark: _Toc206401383][bookmark: _Toc206401384][bookmark: _Toc206401385][bookmark: _Toc206401386][bookmark: _Toc206401387][bookmark: _Toc206401388][bookmark: _Toc206401389][bookmark: _Toc206401390][bookmark: _Toc206401391][bookmark: _Toc206401392][bookmark: _Toc206401393][bookmark: _Toc206401394][bookmark: _Toc206401403][bookmark: _Toc206401404][bookmark: _Toc206401405][bookmark: _Toc206401406][bookmark: _Toc206401407][bookmark: _Toc206401408][bookmark: _Toc206401409][bookmark: _Toc206401410][bookmark: _Toc206401411][bookmark: _Toc206401412][bookmark: _Toc206401413][bookmark: _Toc206401665][bookmark: _Toc206401666][bookmark: _Toc206402046][bookmark: _Toc206402047][bookmark: _Toc206402048][bookmark: _Toc206402049][bookmark: _Toc206402050][bookmark: _Toc206402051][bookmark: _Toc206402052][bookmark: _Toc206402053][bookmark: _Toc206402054][bookmark: _Ref14687062][bookmark: _Toc16160290][bookmark: _Toc214011586][bookmark: _Toc220570413]6.5 Documentation
PIR Section 2 (c). Appointed parties to document any 2D documentation not derived from BIM, e.g. typical details.
The following 2D documentation is not derived from BIM.
	Discipline
	Documentation type
	Comments

	Structure
	Typical reo details
	Typical reinforcement details are documented in CAD

	Architecture
	Railing details 
	1:5 Railing details 

	-
	Specifications
	[enter]


[bookmark: _Ref4075110][bookmark: _Toc16160291][bookmark: _Toc214011587][bookmark: _Ref4074051]Table 12: 2d documentation external to BIM
[bookmark: _Toc220570414]6.6 Schedules
[bookmark: _Hlk13238741]PIR Section 2 and 2 (c). Appointed parties are to generate all schedules as extractions from the discipline/trade BIM/s and/or space planning tool. Any schedule not produced by these means must be documented here. The approach for coordinating these detached schedules with other information containers (BIM, dRofus, etc) must be documented and approved by the Queensland Health representative prior to undertaking this work.
[bookmark: _Toc16160292][bookmark: _Ref4075121][list schedules not from BIM and detail the approach to coordinating these schedules with BIM here]
[bookmark: _Ref107326397][bookmark: _Toc214011588][bookmark: _Toc220570415]6.7 Room data sheets
[bookmark: _Hlk13238774]Refer to the DBEP.
[bookmark: _Toc16160353][bookmark: _Toc214011589][bookmark: _Toc220570416]6.8 Operation and maintenance manuals
Document the approach to how operation and maintenance manuals will be delivered to 
Queensland Health.
[enter here]
[bookmark: _Ref4124785][bookmark: _Ref14686822][bookmark: _Toc16160298][bookmark: _Toc214011590][bookmark: _Toc220570417][bookmark: _Hlk13237847]6.9 Federated model and coordination
[bookmark: _Hlk13237943]PIR Section 4.6. Hard clashes; construction tolerances; safe working/maintenance zones; responsibilities and accountabilities; clash detection priorities; tolerance strategy; and outputs (e.g. clash reports, Excel, dashboarding, etc.)
[bookmark: _Toc447286404][bookmark: _Toc16160299]6.9.1 General
[bookmark: _Hlk13237976]The delivery team are to use automated conflict checking/clash detection software during the delivery of the project to determine geometric clashes in each discipline/trade BIM and then in the federated model. Once issues are identified, each discipline/trade shall resolve the model elements within the BIM/s they are responsible for.
The identification and reporting of coordination issues should be held regularly (e.g., weekly or fortnightly) during construction. Identified issues should be reported, tracked, and closed out. These reports should show any outstanding coordination issues between the delivery team members.
[bookmark: _Hlk13237999]Queensland Health expects the coordination to be appropriate to the stage of the project (e.g. reduced coordination issues as the project progresses). Major space planning coordination issues between Architecture, Structure, Mechanical and other relevant services should be resolved during design. Construction coordination issues should be resolved before construction begins on-site. As-built models should be well coordinated.
[bookmark: _Toc16160300][bookmark: _Hlk13238015]6.9.2 Tolerances
[bookmark: _Hlk13238024]The delivery team must set minimum tolerances for clash detection for project stage deliverables. These tolerances may vary between stages, for example, moving from a 100mm tolerance during design to a 25mm tolerance during construction. Consider the differences between coordination tolerances and as-built tolerances.
[enter tolerances here]
6.9.3 Clash tests
[bookmark: _Hlk13238053][All information required to undertake clash tests must be documented in the CBEP]
Consider which stage of the project various clash tests are most appropriate for, e.g. focusing on Architectural vs Structural earlier, before introducing larger services. Consider using tiers or priorities to group and define clash tests.
[enter clash test strategy here]
[bookmark: _Toc447286408][bookmark: _Toc16160304]6.9.4 All other clashes
[bookmark: _Toc447286409][bookmark: _Toc16160305]While the above clashes have been assigned priorities, other clashes will exist within the BIM/s. These other clashes are not ignorable, nor should they be discarded. The intention is to have a federated model that has minimal coordination issues prior to completion of each project stage. There must be documented proof that the delivery team has addressed the coordination issues, where identified.
6.9.5 Coordination responsibilities
a) [bookmark: _Hlk13238162]The delivery team BIM manager facilitates the overall coordination and management of clashes during the design stages.
b) The services consultants are responsible for discovering, managing and resolving clashes between services disciplines prior to the issue of models to the BIM manager for clash detection.
[bookmark: _Toc447286410][bookmark: _Toc16160306]6.9.6 Clash resolution meetings during design stages
Refer to the DBEP.
[bookmark: _Toc447286411][bookmark: _Toc16160307]6.9.7 Clash detection meetings during construction stage
[bookmark: _Hlk13238263]Consider what outcomes are expected from clash meetings – are trade engineers attending to resolve issues, or are BIM coordinators attending to prioritise identified issues in the issue tracking software, etc? What is the approach to hosting productive clash meetings?
The contractor is responsible for arranging similar clash detection meetings during the construction stages.
[enter the approach for clash resolution meetings here]
[bookmark: _Toc16160297][bookmark: _Toc214011591][bookmark: _Toc220570418]6.10 Quality assurance and control
[bookmark: _Hlk13238288]PIR section 4.7. Quality assurance/control procedures; retaining data integrity/accuracy in BIM; and integration approach with cost planning, construction staging/sequencing, SoA, space planning and resulting 2D drawing and schedule outputs.
The below outlines the model and data quality control approaches, including responsible parties and frequency/timeframes.
[enter response/table here]



[bookmark: _Toc220570419]7 Appendices
[bookmark: _Toc16160309][bookmark: _Toc214011593][bookmark: _Toc220570420]7.1 Appendix A
Building information modelling manager
This Appendix is required only for pre-contract evaluation and must be removed post-contract.
[bookmark: _Toc16160310]7.1.1 Building information modelling manager experience
[bookmark: _Hlk13485368]The BIM manager appointed by the delivery team and named in Table 7 have the following experience.

The BIM manager appointed by the delivery team and named in Table 7 have the following experience.
7.1.1.1 Experience
[bookmark: _Hlk13485464][bookmark: _Hlk13485455]PIR Section 4.2. State the experience of the named individual (or individuals) performing BIM management roles, including: number of years, projects delivered, technical competencies communication abilities.
7.1.1.2 Resource allocation
[bookmark: _Hlk13485482]State the estimated time of the named individual (or individuals) performing BIM management roles for the project.

	[bookmark: _Hlk13485491]Stage
	Named resource
	BIM and information management tasks
	Time allocation per week

	
	
	
	

	
	
	
	

	
	
	
	


Table 13: BIM management




[bookmark: _Toc214011594][bookmark: _Toc220570421]7.2 Appendix B – Quantity surveyor requirements or model content plan
Refer to AIQS guidance material
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INSTRUCTIONS

To add the Queensland Health BIM Parameters to your Project follow the steps below:
1. In the Project Browser, right click on one of the QH Schedules (e.g. QH_Major Equipment Data Schedule)
2. Select Copy to Clipboard
3. Open your project in the same instance of Revit
4. In your project, on the Modify tab, select Paste > Paste from Clipboard
5. Repeat for each QH Schedule

This will result in all Queensland Health BIM Parameters being added to your project, assigned to the correct Categories, and will
include the schedules which may be used for QA. Filter the schedules by the QH_Asset Grouping parameter, selecting the
appropriate value (e.g. Major Equipment for the Major Equipment schedule). Category specific schedules will be required for
Systems and will need to be consolidated once exported.

To export Schedules to copy into the QH_BIM Data Uploader follow these steps:

1. Open the schedule to be exported

2. Go to File > Export > Reports > Schedule

3. Save the text file before loading into Excel and copying to the QH_BIM Data Uploader
4. Verfiy column order and check values

5. Repeat for each schedule

Each schedule should align with the corresponding schedule in each sheet of the QH_BIM Data Uploader. The Project BIM Manager
is to consolidate the QH_BIM Data Uploader.xIsx from all sub-consultants into one document before submitting to Queensland
Health.
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